
Thank you for purchasing an Olympus
Digital Voice Recorder.

Please read these instructions for information
about using the product correctly and safely.

Keep the instructions handy for future reference.

To ensure successful recordings, we recommend that
you test the record function and volume before use.
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Microsoft and Windows are registered trademarks of Microsoft Corporation.

Macintosh is a trademark of Apple Inc.

Intel and Pentium are registered trademarks of Intel Corporation.

The SD logo is a trademark.

The SDHC logo is a trademark.

Other product and brand names mentioned herein may be the trademarks or registered
trademarks of their respective owners.

● The contents of this document may be changed in the future without advanced notice.
Contact our Customer Support Center for the latest information relating to product names
and model numbers.

● The utmost care has been taken to ensure the integrity of the contents of this document. In
the unlikely event that a questionable item, error, or omission is found, please contact our
Customer Support Center.

● Any liability for passive damages or damage of any kind occurred due to data loss incurred
by a defect of the product, repair performed by the third party other than Olympus or an
Olympus authorized service station, or any other reasons is excluded from Olympus’s
liability.

Trademarks

IntroductionIntroduction
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Convention Used In this Manual

• The word “card” is used to refer to the SD
card.

• The word “DSS Player” is used to refer to
the DSS Player Pro Dictation Module in
Windows environment and DSS Player in
Apple Macintosh environment.

• The Notes at the bottom of a page are
used for additional information,
exceptions, or related events.

• Words in uppercase form such as PLAY
or REC are used to describe a function
or button on the recorder.

Safe and Proper
Usage

Before using your new recorder, read
this manual carefully to ensure that you
know how to operate it safely and
correctly. Keep this manual in an easily
accessible location for future reference.

• The warning symbols indicate important
safety related information. To protect
yourself and others from personal injury
or damage to property, it is essential that
you always read the warnings and
information provided.

General Precautions

● Do not leave the recorder in hot, humid
locations such as inside a closed
automobile under direct sunlight or on the
beach in the summer.

● Do not store the recorder in places exposed
to excessive moisture or dust.

● Do not use organic solvents such as
alcohol and lacquer thinner to clean the
unit.

● Do not place the recorder on top of or near
electric appliances such as TVs or
refrigerators.

● Avoid recording or playing back near
cellular phones or other wireless
equipment, as they may cause interference
and noise. If you experience noise, move
to another place, or move the recorder
further away from such equipment.

● Avoid sand or dirt. These can cause
irreparable damage.

● Avoid strong vibrations or shocks.
● Do not disassemble, repair or modify the

unit yourself.
● Do not operate the unit while operating a

vehicle (such as a bicycle, motorcycle, or
go-cart).

● Keep the unit out of the reach of children.

<Warning regarding data loss>
Recorded content in memory may be
destroyed or erased by operating mistakes,
unit malfunction, or during repair work.

It is recommended to back up and save
important content to other media such as a
computer hard disk.
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Batteries

 Danger
• Do not solder lead wires or terminals directly

onto a battery or modify it.
• Do not connect the = and - terminals

together. This may cause fire, overheating or
electric shock.

• When carrying or storing the battery, be sure
to put it in the provided case to protect its
terminals. Do not carry or store the battery
with any metal objects (such as key rings).
If this warning is not followed, fire,
overheating or electric shock may occur.

• Do not connect the batteries directly to a
power outlet or a cigarette lighter of an
automobile.

• Do not insert the batteries with their = and
- terminals reversed.

• If any liquid from a battery gets into your
eyes, promptly wash it off with clean water
and consult your doctor at once.

• There is a hole from which gas escapes on
the = terminal. Do not cover or block it.

 Warning
• Batteries should never be exposed to flame,

heated, short-circuited or disassembled.
• Do not attempt to recharge alkaline, lithium

or any other non-rechargeable batteries.

General Precautions

• Never use any battery with a torn or cracked
outer cover.

• Keep batteries out of the reach of children.
• If you notice anything unusual when using

this product such as abnormal noise, heat,
smoke, or a burning odor:
1 remove the batteries immediately while

being careful not to burn yourself, and;
2 call your dealer or local Olympus

representative for service.
• Do not expose the batteries to water. Do not

allow water to contact the terminals.
• Do not remove or damage the battery

insulating sheet.
• Do not use the batteries if you find

something wrong with them such as leakage,
color change or deformity.

• Should any battery liquid get on skin or
clothing, promptly wash it off with clean
water.

• Keep batteries away from fire.

 Caution
• Do not subject batteries to strong shocks.
• Do not use batteries of different types,

voltages, and/or brand names.
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1 Getting Started1 Getting Started

Main Features

M
ain
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● Support type of memory: SD card (☞ P.8).

● Three Programmable smart buttons F1, F2 and F3 (☞ P.58).

● Recording and storing voice in Digital Speech Standard Pro (DS2 format).

● Two recording modes, QP (Quality Playback) mode or SP (Standard Playback) mode (☞ P.24).

● Data encryption function for securing recordings on the device.

● Overwrite Recording and Insert Recording (partial insertion) available (☞ P.21, 22).

● Supports USB 2.0. High-Speed, which enables high-speed data transmission from the recorder
to your computer.

● Five folders and up to 200 files/folder, for a maximum of 1000 recordings (☞ P.19).
When using DSS Player, it is possible to create up to a maximum of seven folders (1,400 files) (☞ P.58, 59).

● It has a built-in Variable Control Voice Actuator (VCVA) function (☞ P.25).

● Large LCD screen with backlight.

● Device Lock function to prevent unauthorized access to device (☞ P.58).
Authentication system via password (☞ P.38, 39).

● Index mark function which is useful to search particular points in the dictation (☞ P.47).

● Verbal comment function which allows transcriptionists to instantly search and play back
instructions on their computer (☞ P.46).

● Priority Setting (☞ P.42).

● DSS Player software included (☞ P.59).
It is possible to customize the recorder in a number of ways.
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SD card

1 Card Lock
SD card is equipped with a lock function.
When the lock function is used, important
data is protected by preventing it from being
accidentally overwritten or erased.
When the lock function is set  will appear
on the display.

2 Index Area
For writing down information identifying card
or content.

3 Contact Area
Comes into contact with the recorder’s
signal read contacts.

Memory Card

The above are the standard times, and the available
recording time will vary depending on the card.

*1: Available recording time for one continuous file.
Available recording time may be shorter if many short
recordings are made.

*2:Total recording time of several files. The maximum
recording time per file is 99 hours 59 minutes.

M
em

o
ry C

ard

This recorder uses memory in the form of SD
card memory.

Check the latest operating information on the
Olympus homepage (http://www.olympus.com)
when using cards other than the included card.
In addition, refer to the following pages as well
when handling the card.
• Inserting and Ejecting a SD card (☞ P.16)
• Formatting the Card (Format) (☞ P.54) Memory Sizes of Cards and

Approximate Recording Times*1

Compatible Cards

The recorder supports cards with memory
capacity between 512 MB to 16 GB.

Settings and operating environment
relating to the card

 Memory Size  QP Mode   SP Mode

512MB 38 hr. 30 min.        79 hr.  00 min.

1GB 77 hr. 00 min.  157 hr. 50 min.*2

2GB 152 hr. 30 min. *2  312 hr. 20 min.*2

4GB            305 hr. 50 min.*2  626 hr. 50 min.*2

8GB 624 hr. 30 min.*2 1279 hr. 30 min.*2

16GB          1248 hr. 10 min.*2 2557 hr. 10 min.*2

SD card

2

3
1
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Memory Card

 Warning

• Do not touch the card contacts.
That may damage the card.

• Do not place the card in locations
with static electricity.

• Store the card in a location that is
out of the reach of children. In
case of accidental ingestion,
consult a physician immediately.

Check Card Information (Card Info.)

Information such as the memory capacity and
remaining memory for installed cards can be
displayed on the recorder (☞ P.34).

Notes
• When initializing (formatting) a card, confirm that

no necessary data is stored on the memory card
beforehand. Initialization completely erases the
existing data on the card.

• In some cases cards which have been formatted
(initialized) by another device, such as a computer,
cannot be recognized. Be sure to format them with this
recorder before using.

• The card has a service life. When reaching the end of
its life, writing or erasing data on the card will be
disabled. In this case, replace the card.

• If you use a PC card adapter compatible with the card
to save or delete some data on the card, the maximum
recording time on the card may be decreased. To
recover the original recording time, initialize/format the
card in the recorder.

• Olympus will not be held liable for any data corruption
or loss due to misuse of the media card.

BACK EXIT

Card Info.

     SD
Remain
Capacity

540MB
1.0GB
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$ + (Volume) button
% Fast Forward (9) button
^ PLAY/OK button
& Programmable smart button (F1,

F2, F3)
* Rewind (0) button
(- (Volume) button
) Built-in speaker
- Battery cover
= PC (USB) terminal
q Cradle connector
w Battery cover release button
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Identification of Parts

1SD card slot
2Built-in microphone
3NEW button
4REC button
5REW button
6FF button
7STOP button
8POWER/HOLD switch
9ERASE button
0EAR (Earphone) jack
!MIC (Microphone) jack
@Record indicator light
#Display (LCD panel)

0

7

8

9

1

2

3

4

5

$

^

%

!

@

#
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(

*

)

w

q =

-
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1 Record mode indicator
2 Current folder
3 Memory remaining indicator

(E/F bar)
4 Record indicator
5 Remaining recording time
6 Level meter indicator
7 Microphone sensitivity indicator
8 Current file number
9 Total number of files in the folder

Author ID indicator
 Battery indicator

VCVA  VCVA (Variable Control Voice
Actuator) indicator

Display Status Indicators

0Recording elapsed time
!Playback position bar indicator
@Play indicator
#Total recording time of the

selected file
$Button guide display
%Current Playback time
^Main Button Guide

You can display the Main Button Guide by
using “Main Button Guide” (P.58) of the
customize functions of DSS Player.

 Pending indicator
 Card Lock indicator

 Encryption indicator
 Priority indicator
 Erase Lock indicator

Display in the recording
mode

Display in the playback
mode

025 / 030

DISPLYVERBAL INDEX

DS3400

QP DICT

E F

00 M  10 S
15 H  22 M 30S

 1

 2

 7

 6

 8

 3
 4

 5
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 0

025 / 030

INSERT SPEED INDEX

DS3400

QP DICT VCVA

02 M  50 S
 12M  05S

 !

#
 @  %

 $

/ 030

Y INDEX
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9 M 57S
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1 Lightly press down on the battery cover

release button, then open the battery
cover.

2 Insert two AAA batteries, observing the
correct polarity as shown in the
illustration below, then close the battery
cover.

Installing Batteries

In
stallin

g
 B

atteries

Recharging Battery Pack

The battery indicator on the display changes
as the batteries lose power.

  →    →  

When  appears on the display, replace the
batteries as soon as possible.
When the batteries are too weak, the recorder
shuts down and [  Battery Low ] appears
on the display.

Cautions Concerning the Battery

 Warning
• Using batteries for which part or all

of the external coating (insulating
sheath) is peeling off or batteries
which have ruptured may cause fluid
leaks, overheating, and explosions.
For this reason such batteries should
absolutely not be used.

• Commercially available batteries for
which part or all of the external
coating (insulation sheath) has been
peeled off should absolutely not be
used.

This recorder can be used with AAA Alkaline
Batteries.

Insert the batteries in the direction inscribed on
the inside of the recorder’s battery compartment.
In addition, when inserting the batteries, insert
them so that the tape is under the batteries, as
shown in the illustration. The batteries can then
be removed easily by pulling up the tape. When
pulling on the tape the batteries may suddenly
pop out, so be sure to press down lightly on
the batteries with your finger while pulling.

Unusable batteries

Batteries for which the entire external coating
(insulating sheath) is peeled off (naked batteries),
or those where it has partially been peeled off.
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Installing Batteries
In

stallin
g

 B
atteries

Notes
• Be sure to turn OFF the recorder before replacing

the batteries. Removing the batteries while the recorder
is in use may corrupt the card. If you are recording into
a file and the batteries run out, you will lose your
currently recorded file since the file header will not be
written.  It is crucial to replace the batteries when one
hash mark is shown in the battery icon.

• Be sure to replace both batteries at the same time.
• Never mix old and new batteries, or batteries of

different types and/or brands.
• If it takes longer than 1 minute to replace dead batteries,

you may have to reset the time when you load new
batteries.

• Remove the batteries if you are not going to use the
recorder for an extended period of time.
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Power Supply Power Save Mode
(Power Save)

When the recorder is ON but not in use for 10
minutes, by default, it will switch to power save
mode automatically. To reactivate the recorder
again, operate any button or the slide switch.

You can set the time to enter Power Save
mode from among [5 minutes. ], [10
minutes.], [30 minutes.], [1 hour], and [Off].
To exit power save, press any button.
The [Power Save] setting can be changed
from the Menu. For more details, refer to
“Menu List” (☞ P.33) and “Learning to Use
the Menu” (☞ P.35).

Power Save Setting

P
o

w
er S
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p
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e

BACK EXIT

Power Save
5 minutes

30 minutes
1 hour
Off

10 minutes

When the recorder is not being used, turn the
power off to reduce battery consumption to a
minimum. Even if the power is turned off, existing
data, mode settings, and clock settings will be
maintained.

Turning On the Power

While the recorder’s power is off, slide the
POWER/HOLD  switch in the direction
indicated by the arrow.
The display will turn on, and after [System Check]
appears, the power will be turned on. The resume
function will bring the recorder back to the stop
position in memory before power was turned off.

Turning Off the Power

Slide the POWER/HOLD switch in the
direction indicated by the arrow for 0.5
seconds or longer.
The display shuts off and the power will be turned
off. The resume function remembers the stop position
before the power is turned off.
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HOLD

If you bring the POWER/HOLD switch to the
HOLD position, the current conditions will be
preserved, and all buttons and switches will be
disabled.This feature is useful when the recorder
has to be carried in a bag or pocket.

Set the recorder to HOLD mode

Slide the POWER/HOLD switch to the
HOLD position.
After [Hold] appears on the display, the recorder is
set to HOLD mode.

Exit HOLD mode

Slide the POWER/HOLD switch to the A
position.

H
O

L
D



16

1

Inserting and Ejecting a SD card

In
sertin

g
 an

d
 E

jectin
g

 a S
D

 card

Inserting a SD card

Insert the SD card into the card slot in the
direction shown in the illustration until it
clicks.

When inserting SD card into the SD card slot,
the recorder message [Please Wait] will flash
on the LCD display for a few seconds while
validating the SD card.

Ejecting a SD card

Push the SD card inward once to unlock it,
and let it eject.

Notes
• Insert the card keeping it straight.
• The card stops with a click when it is inserted all

the way.
• Inserting the card the wrong way or at an angle

could damage the contact area or cause the card
to jam.

• If the card is not inserted all the way, data may not
be written to the card.

• Hold the card straight and pull it out.
• If an unformatted card is installed, the recorder will

automatically display the menu format option (☞ P.54).
• Never use any card in the recorder unless it has been

formatted on this unit (☞ P.54).
• Never remove the card while the recorder is in

operation. This may damage the data.
• Releasing your finger quickly after pushing the card

inward may cause it to eject forcefully out of the slot.
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1 Press the 9 or 0 button to select
the item to set.
Select the item from “hour”, “minute”, “year”,
“month” and “day” with a flashing point.

2 Press the + or – button to set.
Follow the same steps by pressing the 9  or
0  button to select the next item, and press
the + or – button to set.

• You can choose between 12 and 24 hour
display by pressing the F2(24H or 12H)* button
while setting the hour and minute.
Example: 5:45 P.M.

5:45 PM (Initial setting)←→ 17:45

PLAY/OK

Setting Time and Date (Time & Date)
S

ettin
g

 Tim
e an

d
 D

ate

Setting the correct time and date on the recorder
is very important since every file recorded on the
recorder will have the time and date information
as part of the file header. This will simplify the
file management aspects later on.

The hour indicator will flash automatically
when you load batteries before using the
recorder for the first time, or after the
recorder has not been used for a long time.
However, when a Password has been set
as the device lock function (☞P.38), the
recorder will go to the time and date set
screen after verification (unlocking).

  5: 00 PM

BACK EXIT

Time & Date

  3 M 15 D 2009 Y

24H

BACK EXIT

Time & Date

  3 M 15 D 2009 Y

  5 : 45 PM

24H
F1, F2, F3 button

PLAY/OK,+, –,
9, 0
button
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• You can choose the order of the year, month,
day by pressing the F2(D/M/Y or Y/M/D or M/
D/Y)* button while setting them.
Example: March 15, 2009

(Initial setting)

*The display will vary depending on the status of the
settings.

3 Press the PLAY/OK button to complete
the setup screen.
The clock will start from the set date and time.
Press the PLAY/OK button according to the time
signal.

Changing the Time and Date

When the recorder’s POWER/HOLD switch is
turned ON the [Time & Date] will be displayed
for two seconds. If the time and date is not
correct, set it using the procedure below.

1 Press the + or – button in the [Device
Menu] screen, then select [Time & Date].
See P.34 regarding the menu.

2 Press the PLAY/OK or 9 button.
The time and date screen appears. The hour
indicator flashes, indicating the start of the time
and date setup process.The following steps are
the same as Step 1 through Step 3 of “Setting
Time and Date (Time & Date)” (☞ P.17).

3 Press the F3(EXIT) or 0 button to
complete the setting.

S
ettin

g
 Tim

e an
d

 D
ate

 3M 15D 2009Y

15D  3M 2009Y

2009Y  3M 15D 

BACK EXIT

Device Menu

Beep
Cue/Rev Sound

Time & Date
USB Class
Reset Settings

Power Save

Setting Time and Date (Time & Date)

Notes
• If you press the STOP button during the setup operation,

the settings are cancelled, and the recorder returns to the
previous screen.

• You can set the time and date from your PC using DSS
Player software (☞ P.59).
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Recording
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2  Basic Operations2  Basic Operations

Recording Related SettingsThe recorder has five folders, A, B, C, D, E
and you can select folder by pressing the
F1(FOLDER) button. These five folders can
be selectively used to distinguish the kind
of recording; for example, Folder A might
be used to store private information, while
Folder B might be dedicated to holding
business information. Up to 200 messages
can be recorded per folder.
By default, the Recording Mode is QP.

Record Function

By default, the RECORD function is configured
to record at the current position (overwrite).
However, that can be changed to any of the
following settings:
• Append: Appends the recording to the end of the

current file (☞ P.20).
• Overwrite: Overwrites the recording starting at the

current position in the file (☞ P.21).
• Insert: Inserts the recording at the current position

in the file (☞ P.22).

Recording related settings can be
configured to provide a suitable recording
environment.
• Microphone Sensitivity (Mic Sense)

(☞ P.23)
• Recording Modes (Rec Mode) (☞ P.24)
• Using the Variable Control Voice Actuator

(VCVA) (☞ P.25)
• Recording Monitor (☞ P.26)
• Verbal Comment (☞ P.46)
• Pending Files (Pending) (☞ P.41)
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Recording

1
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New Recording

Create a new file to record in.

1 Press the NEW button to create a new
file.
aSelected Author ID
bNew file number
cRemaining recording time

2 Press the REC button to start
recording.
The record indicator light glows orange and

 (Record indicator) appears on the
display.
Aim the microphone at the sound source.
When you press the F2 (DISPLY) button
during recording, you can change the LCD
screen displays.

dRecord indicator

3 Press the STOP button to stop
recording.
If you want to append additional recordings to
the same file, press the REC button again.

031 / 030

FOLDER PRIOR MENU

DS3400
QP DICT

New File
E F

Remain
15 H  22 M  40 s

a
b

c

031 / 031

FOLDER PRIOR MENU

DS3400
QP DICT

  02 M  20 s
15 H  02 M  20 s

Notes
• A beep will sound when the remaining recording time reaches 60 seconds, 30

seconds, and 10 seconds while recording.
• When remaining recording time is less than 60 seconds, the record indicator light

starts flashing in orange. When the recording time is decreasing to 30 or 10 seconds,
the light flashes faster.

• [Memory Full] or [Folder Full] will be displayed when the memory or folder capacity
is full.
- Delete any unnecessary files before recording any further (☞ P.29) or transfer

dictation files to your computer using DSS Player Software (☞ P.59).

2

3

2

031 / 031

VERBAL DISPLY INDEX

DS3400
QP DICT

E F

 00 M  10 s
15 H  22 M  30 s

d
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Overwrite Recording

You can overwrite a previously recorded file from any point within
the file.
Note that the overwritten recordings will be erased.

1 Select and play the file you want to
overwrite.
Stop playback at the starting point of overwrite.

2 Press the REC button to start
overwriting.
The record indicator light glows orange and

 (Record indicator) appears on the
display.

aRecording elapsed time
bTotal recording time of the selected file

3 Press the STOP button to stop
overwriting.

Note
• You cannot select a different recording mode (QP, SP) than that of the original file

before overwrite recording.

R
eco

rd
in

g101 / 133

VERBAL DISPLY INDEX

DS3400
QP DICT

E F

 10 M  25 s
00H  14 M  00 sb

a

2

3

Recording

2
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Insert Recording

Additional recording can be inserted into previously recorded file.

1 Select and play the file you want to
insert an additional recording into.

2 While playing the file, press the
F1( INSERT) button to insert an
additional recording.
[Insert Rec?] appears on the display.

3 Press the REC button to start inserting
an additional recording.
The record indicator light glows orange and

 (Record indicator) appears on the
display.
[Insert Rec] and the remaining recording time will
alternate on the display.

4 Press the STOP button to stop
inserting the additional recording.

Notes
• The recording time and date of the file is updated to the time and date of the

inserted recording.

• You cannot select a different recording mode (QP, SP) than that of the original file
before inserting.

R
eco

rd
in

g

Recording

134 / 134

EXIT

DS3400
QP DICT VCVA

00 H  00 M  10 s
33 M  25s

Insert Rec?

134 / 134

VERBAL DISPLY INDEX

DS3400
QP DICT

F

 00 M  13s

4 H  33 M  06 S

E

134 / 134

VERBAL DISPLY INDEX

DS3400
QP DICT

F

  00 M  12s

Insert Rec

E

3

PLAY/OK

1

PLAY/OK

2

4

3
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Microphone Sensitivity (Mic Sense)
M

icro
p

h
o

n
e S

en
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You can switch between two microphone
sensitivit ies to meet recording needs:
[Dictation] for oral dictation and [Conference]
which is suited for situations like meetings and
conferences with a small number of people.
The setting status  will appear on the display
as CONF or DICT .

PLAY/OK

F1, F3 button

PLAY/OK,+, –,
9, 0 button

1 Select [Mic Sense] at the [Record Menu]
screen, then press the PLAY/OK or 9
button.
Refer to P.33 regarding each menu item settings.

2 Press the + or – button to select
[Conference] or [Dictation].
Conference...High-sensitivity mode that records
sounds in all directions.
Dictation...Low-sensitivity mode suited for
dictation.

3 Press the PLAY/OK button to complete
the setup screen.
[Conference Set] or [Dictation Set] will light up
on the display, and it will return to the [Record
Menu] screen.

If you press the  0 or F1(BACK) button the
setting will be cancelled and it will return to the
[Record Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

4 Press the F3(EXIT) or 0 button to
complete the setting.

BACK EXIT

Mic Sense

Dictation
Conference

BACK EXIT

Record Menu
Rec Mode

12

Mic Sense
VCVA

025 / 030

FOLDER PRIOR MENU

DS3400
E

QP DICT

New File02 M  10 s
3 H  08 M  05s

BACK EXIT

Mic Sense
Conference

Dictation 
Set

Dictation



24

2

Recording Modes (Rec Mode)
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The recording mode can choose between QP
(Quality Playback) and SP (Standard
Playback).

PLAY/OK

F1, F3 button

PLAY/OK,+, –,
9, 0 button

1 Select [Rec Mode] at the [Record Menu]
screen, then press the PLAY/OK or 9
button.
Refer to P.33 regarding each menu item settings.

2 Press the + or – button to select [QP]
or [SP].

3 Press the PLAY/OK button to complete the
setup screen.
[QP Set] or [SP Set] will light up on the display,
and it will return to the [Record Menu] screen.

If you press the  0 or F1(BACK) button the
setting will be cancelled and it will return to the
[Record Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

4 Press the F3(EXIT) or 0 button to
complete the setting.
Set Recording Mode is displayed when creating
the New File and during recording.
The recording mode of file recording is displayed
during playback and in stop mode.

Note
• Choose QP mode for recording meetings or lectures

with crisp clarity.

• You cannot select the QP mode when setting the
recorder to the DSS Classic mode.
For details, see “Recording” in the “Customizing the
Recorder” (☞P.58).

BACK EXIT

Record Menu
Rec Mode

12

Mic Sense
VCVA

BACK EXIT

Rec Mode

QP
SP

BACK EXIT

Rec Mode

QP
SP

SP
Set

031 / 030

FOLDER PRIOR MENU

DS3400
SP DICT

New File
E F

Remain
15 H  22 M  40 s
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Using the Variable Control Voice Actuator (VCVA)
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The Variable Control Voice Actuator (VCVA)
is a function that starts recording automatically
when the microphone senses that sounds have
reached a preset threshold volume level, and
automatically pauses when the volume drops
below the threshold. The VCVA feature allows
you to conserve memory by automatically
stopping recording in instances like long silent
periods during meetings.
When this is enabled, VCVA  will appear on the
display.

1 Set the VCVA in the menu to [On].
Refer to P.33 regarding each menu item settings.

2 Press the REC button to start recording.
When the sound volume is lower than the preset
actuation sound level, recording automatically
stops after 1 second approximately,  and “Stand
by” flashes on the display. The record indicator
light glows orange and   (Record indicator)
appears when recording starts and flashes when
recording pauses.

Adjust the Start/Stop Actuation Level

While the recorder is in recording mode,
press the 9 or  0 button to adjust the
actuation level.
The VCVA level can be set to any of 15 different
values. The higher the value is, the more sensitive
the recorder can react to sounds. At the highest value,
even the faintest sound will activate recording.
The VCVA actuation level can be adjusted according
to the ambient (background) noise.

Notes
• The start/stop actuation level also varies depending on

the selected microphone sensitivity mode (☞P.23).

• To ensure successful recordings, prior testing and
adjustment of the start/stop actuation level is
recommended.

• If the recorder detects an input that exceeds the Start
level, the dotted line of the Level meter indicator will
change to the full line, and the recorder starts recording.

a Start level
(Varies according to
the sound volume
being recorded)

b Level meter
indicator (moves to the
left/right according to
the set level)

PLAY/OK 9, 0 button

134 /134

VERBAL DISPLY INDEX

DS3400
QP DICT VCVA

Standby

E F

1 H  25 M  01 s

134 /134

VERBAL DISPLY INDEX

DS3400
QP DICT VCVA

VCVA Level 05

E F

1 H  25 M  02 s

ab

REC
button
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Recording Monitor

It is possible to monitor your recording by
listening to the recording while recording is in
progress. Insert the earphone plug into the
earphone jack and use the + or – button to
control the volume level.

Note
• Insert the plugs in to the end as shown in the illustration

when inserting the earphone or external microphone.
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+ / –
(Volume)
button



27

2
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g
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You can start playing a file at any point.

1 Select the file, then press the PLAY/
OK button to start playback.
The  (Play indicator) appears on the
display.

aPlay indicator

2 Press the + or – button to adjust the
volume.
The display shows the volume level. You can
choose between 00 to 30.
bVolume level

3 Press the STOP button at any point
you want to stop the playback.

101 / 133

INSERT SPEED INDEX

DS3400
QP DICT

00 M  05 s
 27 M  58s

a

101 / 133

INSERT SPEED INDEX

DS3400
QP DICT

00 M  07 s
Volume 15b

PLAY/OK

2

3

1
PLAY/OK

1
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            How to Cancel

Press the PLAY/OK or STOP
button.

Press the PLAY/OK or STOP
button.

Release the button.

Release the button.

P
layin

g

Playing

Playback
functions
Fast
Forward
(FF)

Rewind
(REW)

Cue
(CUE)

Review
(REV)

Playback
Speed

Operation

Press the 9 or FF button once while stopped.

Press the 0 or REW button once while stopped.

Press and Hold the 9 or FF button while stopped
or playing a file.

Press and Hold the 0 or REW button while stopped
or playing a file.

Press the F2 (SPEED) button during playback.

➥ Every time the F2(SPEED) button is pressed, the
playback speed will switch.

Play(playback): Playback at normal speed.

Slow Play (slow playback): Playback speed
slows down (-50%), and “Slow play” will turn on.

Fast Play (fast playback): Playback speed
becomes faster (+50%), and “Fast play” will turn on.

Notes
• If you press the 9 or FF button once while fast-forwarding or twice while stopped, the recorder will stop at the end of

the file (F.Skip).

• If you press the 0 or REW button once while rewinding or twice while stopped, the recorder will stop at the beginning
of the file (B.Skip). If the 0 or REW button is pressed within 2 seconds, the recorder skips to the beginning of the
previous file.
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Erasing a File

Erasing or deleting a file from any of the folder on the recorder is a
very simple process.

1 Select the file you want to erase.

2 Press the ERASE button.

3 Press the + button to select [File
Erase], then press the PLAY/OK
button.

4 Press the + button to select [Start],
then press the PLAY/OK button.
The display changes to [File Erase !] and
erasing will start.

[Erase Done] is displayed when the file is
erased. File numbers will be reassigned
automatically.

Notes
• An erased file cannot be restored.
• Files cannot be erased in the following cases.

- File being set [Lock] (☞ P.40).
- The SD card lock is turned on (☞ P.8).

E
rasin

g
Erasing

029 / 031

EXIT

DS3400
QP DICT

All Erase
File Erase
Cancel

3

4

PLAY/OK

2

PLAY/OK

PLAY/OK

File Erase !

029 / 030

DS3400
QP DICT

Erase Done

029 / 031

BACK

DS3400
QP DICT

File Erase
Start
Cancel

EXIT

All Erase
File Erase
Cancel
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Erasing All Files in a Folder

All files in a folder can be erased simultaneously.

1 Select the folder you want to erase.

2 Press the ERASE button.

3 Press the +  button to select [All
Erase], then press the PLAY/OK
button.

4 Press the + button to select [Start],
then press the PLAY/OK button.
The display changes to [All Erase !] and erasing
will start.

[Erase Done] is displayed when the files are
erased. Any locked files in the folder will be
reassigned new file numbers in ascending
order.

Notes
• The erasing process may take up to 10 seconds. Do not interrupt this process!

Data will be destroyed.
• Files cannot be erased in the following cases.

- File being set [Lock] (☞ P.40).
- The SD card lock is turned on (☞ P.8).

Erasing

E
rasin

g

029 / 030

EXIT

DS3400
QP DICT

All Erase
File Erase
Cancel

3

4

PLAY/OK 2

PLAY/OK

PLAY/OK

All Erase !

000 / 000

DS3400
E

QP DICT

Erase Done

/ 030

BACK

DS3400
E

QP DICT

All Erase
Start
Cancel

029 / 031

EXIT

All Erase
File Erase
Cancel
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Partially Erasing a File

You can erase a selected file in part.

1 Start playback for the file you want to
erase partially.

2 Press the ERASE button at the point to
start erasing.
While playback continues, [Partial Erase] will
appear on the display.

3 Press the ERASE button at the point
to end erasing.
The erase starting point (time) set in step 2 and
the ending point (time) set in this step will
alternate on the display for 8 seconds.
If you playback to the end of file or to the start
position of the Verbal comment (☞ P.46), that
will mark the end position for the partial erase
automatically.

E
rasin
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PLAY/OK

2
3

134 / 134

INSERT SPEED INDEX

DS3400
QP DICT

  45 M  02 s
01 H  55M  25s

EXIT

45 M  02 s
01H  55 M  23s

Partial Erase

134 / 134

EXIT

DS3400
QP DICT

05 M  01 s
Partial Erase

Start

134 / 134

EXIT

DS3400
QP DICT

 45 M  32 s
Partial Erase

End

Erasing
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4 Press the ERASE button to confirm
erase.
The display changes to [Partial Erase!] and
erasing will start.

When [Erase Done] appears on the display,
partial erase is complete.

Notes
• If the ERASE button is not pressed within 8 seconds after the “Partial Erase Start”

and “Partial Erase End” are alternately displayed, the recorder will revert to stop
status.

• An erased file cannot be restored.
• Files cannot be Partial erased in the following cases.

- File being set [Lock] (☞ P.40).
- Files that Verbal comment is being played back (☞ P.46).
- The SD card lock is turned on (☞ P.8).

Erasing

E
rasin

g

134 / 134

DS3400
QP DICT

1 H  20 M  35 s
Partial Erase !

134 / 134

DS3400
QP DICT

1 H  20 M  35 s
Erase Done

PLAY/OK

4
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Menu List

M
en
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Display
Menu

Lock

Rec Mode

VCVA

Mic Sense

Backlight

LED

Contrast

Language

Off, On

Dictation, Conference

QP, SP

Off, On

On, Off

On, Off

Program contrast level 01~12 (Default is 6).

● Menu Setting (while the recorder is stopped, press the F3(MENU) button

    P.42

    P.24

    P.23

    P.25

    P.49

Second layer Setting  Ref.Page

    P.48

    P.50

    P.51

3  Advanced Operations3  Advanced Operations

Main Menu

File Menu

Record
Menu

Device Menu
(To the next page)

English, Deutsch, Français, Español,
Italiano, Русском

Information The file information is displayed.

    P.43

Priority

Finished, Pending

Cancel, Set

    P.41

    P.40

Pending

Work Type Edit the Work Type and Option Item.

    P.37
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Menu List

M
en

u
 L

ist

Beep

Format

USB Class

Time & Date

Power Save

Reset Settings

Card Info.

Initializes the card.

Composite, Storage

On, Off

Model Name, Version, Serial

In order of hour, minute, year, month and
day.

In order of 5 minutes, 10 minutes,
30 minutes, 1 hour and Off.

Returns the menu settings to their initial
state.

Device
Menu

    P.52

    P.55

    P.14

    P.17

    P.57

    P.54

    P.9

Second layer Setting

Remain, Capacity

    P.56

Notes
• The selectable language varies depending on the countries where the product was purchased.
• Items appear in bold letters in the “Setting” column to indicate that they are the initial settings.

System Info.

 Ref.PageMain Menu

File Menu
(To the page 33)

Cue/Rev Sound On, Off     P.53
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3 Press the PLAY/OK or 9 button.
Move to the setting of the selected menu items.

4 Press the + or – button to move to the
menu item to be set.

5 Press the PLAY/OK or 9 button.
Move to the setting of the selected item.

6 Press the + or – button to change the
setting.

7 Press the PLAY/OK button to complete
the setup screen.
If you press the 0 or F1(BACK) button, the
setting will be cancelled and it will return to the
menu.
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

8 Press the F3(EXIT) or 0 button to
complete the setting.

1 Press the F3(MENU) button.
The [Main Menu] screen will appear on the
display (☞ P.33).

2 Press the + or – button to move to
[Main Menu] item to be set.
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Learning to Use the Menu

EXIT

Main Menu
File Menu

Display Menu
Device Menu

Record Menu

BACK EXIT

Record Menu
Rec Mode

VCVA
Mic Sense

EXIT

Main Menu
File Menu

Display Menu
Device Menu

Record Menu

BACK EXIT

Rec Mode
QP
SP

PLAY/OK

F1, F3 button

PLAY/OK,+, –,
9, 0
button

To navigate through the different options in the
Menu, use the Menu List flow chart (☞ P.33,
34) and the following steps to modify or
change any settings.



36

3

S
electin

g
 F

o
ld

ers an
d

 F
iles

Selecting Folders and Files

Changing Folders

1 While the recorder is stopped, press the
F1(FOLDER) button.
The folder list screen will be displayed.

2 Press the + or – button to select the
folder, then press the PLAY/OK button.
This will change the folder.
You can switch folders by pressing the
F1(FOLDER) button.

FOLDER

QP DICT

Folder AA
B
C
D
E

Folder B
Folder C
Folder D
Folder E

EXIT

FOLDER

QP DICT

Folder AA
B
C
D
E

Folder B
Folder C
Folder D
Folder E

EXIT

001 / 010

FOLDER PRIOR MENU

DS3400
QP DICT VCVA

00M  00 s
 05 M  00s

C

a

b

Changing File

1 While the file is being displayed, press
the 9 or 0 button.
This will change and display the file number order
for files within the folder.

PLAY/OK

F1 button

PLAY/OK,+, –,
9, 0
button

aCurrent file number
bTotal number of
    recorded files in the
    folder

The scroll bar will appear when all of
the items cannot be displayed in the
menu or list display screen.

Scroll bar

FOLDER

QP DICT

Folder AA
B
C
D
E
F

Folder B
Folder C
Folder D
Folder E
Folder F

EXIT
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1 Select the file whose information you
want to display.
Refer to P.36 regarding file selection.

2 Select [Information] at the [File Menu]
screen, then press the PLAY/OK or 9
button.
The file information is displayed.
Refer to P.33 regarding each menu item settings.
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The recorder can display a variety of
information related to the current file.

EXIT

Information
File Name
D S 3 4 0 0 0 6 . D S 2

03M15D2009Y  12:23PM

Author ID

Rec Time

BACK

DS3400

PLAY/OK

The Displayed Information

The following information will be displayed.
[File Name]...File name
[Rec Time]...Time and date the file was

recorded.
[Author ID]...Display the Author ID of file.
[Work Type]...Display the Work Type ID of file.
[Option Item]...Display the Option Item which has
been set.

Displaying File Information (Information)

Note

• When the file that Work Type or the Option Item is set
is transferred from PC to this unit, the information will
be displayed on the File Information.

PLAY/OK
9 button

BACK EXIT

File Menu

Pending
Lock

Priority

Work Type
Information
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Device Lock Function

Unlocking the Recorder

When the password registry is done, the
recorder will prompt for password on startup.

Unlock the recorder’s device lock through the
method below.
The default password when using the recorder
for the first time is “0000”.

Recorder access can be restricted by enabling
the device lock function. Authentication via
password  can act as a safe guard for your
data even in case the recorder is lost or left
unattended.
Password registry can be performed by using
DSS Player (☞ P.59).

Unlocking the Recorder with a
Password

1 Select the numbers you want to enter
by pressing the +, –, 9 or 0 button
to move the cursor.

2 Press the PLAY/OK button to select a
number.
A * will appear in the selected first digit and the
blinking cursor will move to the next one over (to
the right). Repeat steps 1 and 2 to enter all four
digits.
Pressing the ERASE button at any time will erase
the last entry and move the cursor to the previous
entry (to the left).

3 After all four digits have been entered,
press the F2(ENTER) button.
If the 4 digit number entered matches the
registered password then the startup message
will appear and the recorder will start up.

Entry column

Cursor

Unlock Device
Enter Password

Unlock Device
Enter Password

Unlock Device
Enter Password

Unlock Device
Enter Password

ENTER

F2 button

PLAY/OK,+, –,
9, 0
button

PLAY/OK

D
evice L

o
ck F

u
n

ctio
n
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Device Lock Function

Unlock Device
Enter Password

Device is
Locked

09 : 59

Authentication Halt Mode

If there is no password match after five
tries the recorder will enter password
input halt mode for ten minutes.
After ten minutes have passed the
mismatch history will be erased and it
will once again return to the password
input screen.
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Locking Files (Lock)

When a file is set to [Lock],   will appear on
the display, allowing you to prevent important
files from accidental erase. Furthermore, the
file will not be erased even when all files within
a folder are erased.

1 Select the file you want to Lock.

2 Select [Lock] at the [File Menu] screen, then
press the PLAY/OK or 9 button.
Refer to P.33 regarding each menu item settings.

L
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3 Press the + or – button to select [On]
or [Off].
On...Locks the file and prevents it from
being erased.

 appears on the display.

Off...Unlocks the file and allows it to be erased.

4 Press the PLAY/OK button to complete the
setup screen.
[File Lock On] or [File Lock Off] will light up on
the display, and it will return to the [File Menu]
screen.

If you press the  0 or F1(BACK) button the
setting will be cancelled and it will return to the
[File Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

5 Press the F3(EXIT) or 0 button to
complete the setting.

PLAY/OK

F1, F3 button

PLAY/OK,+, –,
9, 0
button

BACK EXIT

File Menu

Pending
Priority

Lock
Work Type
Information

029 / 030

BACK EXIT

Lock

OnC
Off

029 / 030

BACK EXIT

Lock

OnC
Off

 File Lock 
On

029 / 030

FOLDER PRIOR MENU

DS3400
E

QP CONF

New File02 M  10 s
3 H  08 M  05s
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Pending Files (Pending)

When you set [Pending] to the file, the file becomes
“Pending file” and the editing sign of  will appear
on the display. If “Download file” is set to “Finished
file” by DSS Player, the [Pending] file is not
transferred and only [Finished] file (edited file) will
be transferred to your PC.
For details, see “Recording” in the “Customizing the
Recorder” (☞ P.58).

1 Select [Pending] at the [File Menu] screen,
then press the PLAY/OK or 9 button.
Refer to P.33 regarding each menu item settings.

2 Press the + or – button to select
[Pending] or [Finished].
Pending...Sets to a file of “Editing” and  appears
on the display.
Finished...Sets to a file of “already edited”.

3 Press the PLAY/OK button to complete
the setup screen.
[Pending Set] or [Finished Set] will light up on the
display, and it will return to the [File Menu] screen.

If you press the  0 or F1(BACK) button the setting
will be cancelled and it will return to the [File Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

4 Press the F3(EXIT) or 0 button to
complete the setting.

F1, F3 button

PLAY/OK,+, –,
9, 0
button

BACK EXIT

File Menu

Pending
Lock

Priority

Work Type
Information

029 / 030

BACK EXIT

Pending

Pending
Finished

029 / 030

BACK EXIT

Pending

Finished

 Pending 
Set

029 / 030

FOLDER PRIOR MENU

DS3400
E

QP CONF

New File02 M  10 s
3 H  08 M  05s
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Performing the Setting from the Menu

1 Select the file which you would like to
set the Priority level for.

2 Select [Priority] at the [File Menu]
screen, then press the PLAY/OK or 9
button.

3 Press the + or – button to select [Set]
or [Cancel], then press the PLAY/OK
button.
[Set]...High Level.
[Cancel]...Normal Level.

Setting Priority Levels (Priority)

S
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F2 button

PLAY/OK,+, –,
9 button

a Priority indicator

By default, F2 button is programmed with
Priority function. The setting can also be
performed from the menu.
You can set a priority level on each file
recorded. You can choose between “HIGH”
and “NORMAL”  The default is Normal level.

To Set a Priority Level on a File

To Set the F2(PRIOR) Button

1 Select the file you want to perform the
setting on, then press the F2(PRIOR)
button.
Each time the F2(PRIOR) button is pressed the
Priority level will change (HIGH/NORMAL). When
the HIGH level setting is selected,  will appear
on the display.
Perform the setting in the same manner after
creating a New file.

029 / 030

FOLDER PRIOR MENU

DS3400
QP DICT

0 H  00M  00 s
15 H  22 M  40s

a

BACK EXIT

File Menu

Pending
Lock

Priority

Work Type
Information

029 / 030

BACK EXIT

E

Priority

Set
Cancel

PLAY/OK



43

3

Setting the Author ID and Work Type

Every file recorded on the recorder will include
the Author ID and Work Type as part of its
header information. To create multiple Author
IDs and Work Types on the recorder, use the
bundled DSS Player software to create and
upload a Data list (list of Author IDs and Work
Types) to the recorder. For more details, refer
to the Online help for DSS Player (☞ P.63).
By default the Author ID is set to “DS3400”.

Setting an Author ID

1 Turn ON the recorder.
When [Prompt for author ID at Power-on.] has
been set through DSS Player (☞P.59), the
registered Author ID List will appear.

2 Press the + or – button to select the
Author ID that you want to assign to the
recorder from the ID list.

3 Press the PLAY/OK button to set the ID.
When more than one Author ID exist on the
recorder, the ID list will be displayed.

ID 1

ID 2

ID 3

ID10

 Author  List

EXIT

Author ID
AUTHOR A
AUTHOR B

AUTHOR D
AUTHOR E
AUTHOR F

AUTHOR C
F1,F2,F3
button

PLAY/OK,+, –,
9, 0
button

Note
• Up to 10 Author ID entries can be registered (up to a

maximum of 16 characters).
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Setting the Author ID and Work Type

Setting the Work Type

Up to 10 Work Types can be registered in the
DSS Player software and uploaded to the
recorder. Each Work Type can have up to 10
Option Items associated with it. The Work
Types and Option Items can be used on the
recorder to populate the recording file header
information. Refer to the Online Help for DSS
Player (☞ P.63) regarding registration/set up
details and Option Item through DSS Player.

1 While the recorder is stopping mode,
press the NEW button.
When [Prompt for Worktype ID on new
recordings.] has been set through DSS Player (☞
P.59), the Work Types uploaded to the recorder
will appear in a list.

2 Press the + or – button  to select a
Work Type from the Work Type list.

3 Press the PLAY/OK button to select the
Work Type.
The selected Work Type and a maximum of 10
Option Items registered for that Work Type will
be recorded in the New File header information.
When the item of Option Item Label within the
selected Work Type is possible to set for Value
input, it will take you to the file information input
screen (☞ P.45). For more details, refer to the
Online help for DSS Player (☞ P.63).

Editing the Work Type

The Work Type information of the recorded or
uploaded files can be edited with the menu
settings of the recorder (☞ P.33)

1 Select the file you want to edit its Work
Type information (☞ P.36).

2 Select [Work Type] at the [File Menu]
screen, then press the PLAY/OK or 9
button.
The Work Type setting screen will appear.

3 Press the F2(EDIT) button.
The modification method confirmation screen will
appear.

4 Press the + or – button to select [Edit
Work Type] or [Select From Work Type
List], then press the PLAY/OK button.
Edit Work Type...This will take you to the file
information input screen (☞ P.45) and allow you
to modify the Work Type information that has been
recorded for the file.
Select from Work Type List...You can re-select
Work Type from the Work Type list.
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 Work Type List

Type 1

Type 2

Type 3

Type 10

SCAN EXIT

E

029/030
W o r k  T y p e 1
W o r k  T y p e 2

W o r k  T y p e 4
W o r k  T y p e 5
W o r k  T y p e 6

W o r k  T y p e 3

BACK EXIT

File Menu

Pending
Lock

Priority

Work Type
Information

EDIT EXIT

029/030
Work Type
Letter
Reference No

Subject

BACK

EXIT

E

029/030
Work Type
MRI

1 2 3 4 5 6 7 8 9 0 1 2 3 4
DEP

BACK

Select From
Work Type List

Edit Work Type
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Inputting Option Item Value

1 Press the + or – button on the file
information input screen to select the
targeting Option Item, then press the
PLAY/OK button.
The input screen will be displayed.
When inputting an Option Item value into a New
file or the file with a re-selected Work Type, only
eligible input characters as specified in the DSS
Player can be entered.

2 Entering characters.
Enter characters through the following method.

● Character selection
+, –, 0, 9 button... Select the character
string (numbers, alphabets or symbols) displayed
in the Keyboard window to move the cursor up,
down, left and right by pressing.

● Character confirmation
PLAY/OK button... Use this button to confirm
your selection.

● Moving the entry column
When pressing the + button if the cursor is on top
of the Keyboard window, the cursor will disappear.
An Entry column within the input value display area
will change from flashing to lighting. The Entry
column can be moved when it is lit.
9 button... Each press of the button moves the
Entry column one space to the next (right). The
Entry column can be moved up to the space next
(right) to the last character.
0 button... Each press of the button moves the
Entry column one space to the previous (left). The
Entry column can be moved up to the first character.
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– button...The Entry column changes from
lighting to flashing. The cursor is lit on the “0”
string within the keyboard Window, and makes
character selection available.

Entry is performed by insert entry. When the
character in the Entry column has already been
finalized, the character after the cursor will move
one column to the right.

● Maximum entered character count
The Option item value can be entered up to the
number of characters specified below. Preset
default values can also be set for the option items
to simplify data entry process.

Option Item Value... 20 characters

● Cancelling the entered contents
Press the F1(BACK) button to select [Yes],
then press the PLAY/OK button during
entry...This will erase the entered contents for
this item and return you to the File information
input screen.

Press the F3(EXIT) button to select [Yes],  then
press the PLAY/OK button during entry... This
will erase all of the finalized contents for the items,
and the recorder will return to stopped state in the
New file or the state before entering Menu settings.

3 Press the F2(FINISH) button.
The recorder will return to the File information
input screen.
When you create a New File and input a Work
Type, press the F2 (FINISH) button again in the
File information screen to get entered into the stop
state in the New File.

a Input value display area
b Keyboard window
c Entry column
d Cursor

Setting the Author ID and Work Type

SCAN FINISH EXIT

E

029/030
Work Type
Letter
Reference No

Subject
012

File information
input screen

Option Item value
input screen

FINISH EXIT

E
0 1

BACK

Reference No

 c

FINISH EXIT

E
0 1

0 1 2 3 4 5 6 7 8 9 # , - &

BACK

Reference No

OPQRSTUVWXZ_@
ABCDEFGHIJKLMN

 a

 b

 d
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Locating a Verbal Comment

2 While playing back a file, press and hold
the 9 or 0 button.
The recorder stops for 1 second when it reaches
the Verbal Comment.

Clearing an Verbal Comment

3 While playing a Verbal Comment, press
the ERASE button.

4 Press the + button to select [Clear],
then press the PLAY/OK button.
The Verbal Comment is erased.

029 / 030

VERBAL DISPLY INDEX

DS3400
QP DICT

 10 M  56 s

Verbal Comment
  22M  40 s

E F

029 / 030

INSERT SPEED INDEX

DS3400
QP DICT

 10 M  56 s

Verbal Comment
  22M  40 s

029 / 030

DS3400
QP DICT

Verbal Comment

Cancel
Clear

F1 button

PLAY/OK, +,
9, 0
button

Notes
• Up to 32 Verbal Comment can be set in a file.
• When a file is locked or set to read-only, or when the

SD card lock is enabled Verbal Comment cannot be
erased. Clear the settings before erasing.

• When the recorder has been set to DSS Classic mode
Verbal comments cannot be recorded.
For details, see “Recording” in the “Customizing the
Recorder” (☞ P.58).

Verbal Comment

The data recorded with the F1(VERBAL)
button being pressed during recording, is
recorded as a Verbal comment position (a
position within a file) in the header.
It is possible to instantly search and play back
Verbal comment sections through DSS Player,
thereby making it useful for things like giving
instructions to transcriptionists.

Setting a Verbal Comment

1 While the recorder is recording mode,
press and hold the F1(VERBAL)  button,
then release it when you want to stop.
Audio recorded while continuing to hold the
F1(VERBAL) button will be recorded as Verbal
Comment.

ERASE
button

PLAY/OK
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Index Marks

Index marks can be placed in a file during
recording or playback. Index marks are used
to provide a quick and easy way to identify
important or significant parts within the file.

PLAY/OK

Setting an Index Mark

1 While the recorder is recording or in
playback mode, press the F3(INDEX)
button to set an Index mark.
An index number appears on the display.

Locating an Index Mark

2 While playing back a file, press and hold
the 9 or 0 button.
The recorder stops for 1 second when it reaches
the Index mark.

Clearing an Index Mark

3 Locate the Index mark you want to clear.

4 While the index number appears for
approximately 2 seconds on the display,
press the ERASE button.
The Index mark is erased.

In
d

ex M
arks

F3 button

9, 0
button

ERASE
button

029 / 030

INSERT SPEED INDEX

DS3400
QP DICT

3H  10 M  56 s
22M  40 s

Index 01 Set

029 / 030

INSERT SPEED INDEX

DS3400
QP DICT

3H  10 M  56 s
  22M  40 s

Index 01 Clear

029 / 030

INSERT SPEED INDEX

DS3400
QP DICT

3H  10 M  56 s
22M  40 s

Index 01

Notes
• Up to 32 Index marks can be set in a file.
• When a file is locked or set to read-only, or when the

SD card lock is enabled Index mark cannot be erased.
Clear the settings before erasing.
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Language (Language)

You can select the display language for this
recorder.
The selectable language varies depending on
the countries where the product was
purchased.

1 Select [Language] at the [Display Menu]
screen, then press the PLAY/OK or 9
button.
Refer to P.33 regarding each menu item settings.

BACK EXIT

Display Menu
Backlight

12

Contrast
LED
Language

PLAY/OK PLAY/OK,+, –,
9, 0
button

2 Press the + or – button to set the language.
English...Displays in English.
Deutsch...Displays in German.
Français...Displays in French.
Español...Displays in Spanish.
Italiano...Displays in Italian.
Русском...Displays in Russian.

3 Press the PLAY/OK button to complete
the setup screen.
The displayed language is changed and will return
to the [Display Menu] screen.

If you press the  0 or F1(BACK) button the
setting will be cancelled and it will return to the
[Display Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

4 Press the F3(EXIT) or 0 button to
complete the setting.

BACK EXIT

Language

English

BACK EXIT

Language

English

English
Set

F1, F3 button

Note
• The selectable language varies depending on the

countries where the product was purchased.
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2 Press the + or – button to select [On]
or [Off].
On...Backlight is enabled.
Off...Backlight is disabled.

3 Press the PLAY/OK button to complete
the setup screen.
[On Set] or [Off Set] will light up on the display, and
it will return to the [Display Menu] screen.

If you press the  0 or F1(BACK) button the
setting will be cancelled and it will return to the
[Display Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

4 Press the F3(EXIT) or 0 button to
complete the setting.

B
acklig

h
t

Backlight (Backlight)

When the display backlight is set to [On], the
backlight will light up for about 10 seconds
when a button is pressed.
This is useful in that it allows you to check the
display even in dark locations.

1 Select [Backlight] at the [Display Menu]
screen, then press the PLAY/OK or 9
button.
Refer to P.33 regarding each menu item settings.

BACK EXIT

Display Menu
Backlight

12

Contrast
LED
Language

BACK EXIT

Backlight

On
Off

BACK EXIT

Backlight

On
Off

On
Set

PLAY/OK PLAY/OK,+, –,
9, 0
button

F1, F3 button



50

3

2 Press the + or – button to select [On]
or [Off].
On...LED light will be set.
Off...LED light will be cancelled.

3 Press the PLAY/OK button to complete
the setup screen.
[On Set] or [Off Set] will light up on the display, and
it will return to the [Display Menu] screen.

If you press the 0 or F1(BACK), the setting will
be cancelled and it will return to the [Display Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

4 Press the F3(EXIT) or 0 button to
complete the setting.

L
E

D

LED (LED)

You can set it so the Record indicator light does
not turn on.

PLAY/OK PLAY/OK,+, –,
9, 0
button

1 Select [LED] at the [Display Menu]
screen, then press the PLAY/OK or 9
button.
Refer to P.33 regarding each menu item settings.

BACK EXIT

Display Menu
Backlight

12
LED
Contrast

Language

BACK EXIT

LED

On
Off

BACK EXIT

LED

On
Off

On
Set

LED
(Record
indicator light)

F1, F3 button
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LCD Contrast Adjustment (Contrast)

Display contrast can be adjusted from level 01
to 12.

1 Select [Contrast] at the [Display Menu]
screen, then press the PLAY/OK or 9
button.
Refer to P.33 regarding each menu item settings.

BACK EXIT

Display Menu
Backlight

12

Contrast
LED
Language

PLAY/OK PLAY/OK,+, –,
9, 0
button

2 Press the + or – button to set the
contrast level.
You can adjust the LCD display contrast level from
01 to 12.

3 Press the PLAY/OK button to complete
the setup screen.
The set contrast level lights up and will return to
the [Display Menu] screen.

If you press the 0 or F1(BACK), the setting will
be cancelled and it will return to the [Display Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

4 Press the F3(EXIT) or 0 button to
complete the setting.

BACK EXIT

Contrast
+

-

Level
06

BACK EXIT

Contrast
+

-

Level
06

Level 06
Set

F1, F3 button



52

3

2 Press the + or – button to select [On]
or [Off].
On...System sounds are enabled.
Off...System sounds are disabled.

3 Press the PLAY/OK button to complete
the setup screen.
[On Set] or [Off Set] will light up on the display, and
it will return to the [Device Menu] screen.

If you press the  0 or F1(BACK) button the setting
will be cancelled and it will return to the [Device Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

4 Press the F3(EXIT) or 0 button to
complete the setting.

System Sounds (Beep)

S
ystem

 S
o

u
n

d
s

When this is set to [On], the recorder beeps to
alert you to button operations or warn you of
errors.

PLAY/OK PLAY/OK,+, –,
9, 0
button

1 Select [Beep] at the [Device Menu]
screen, then press the PLAY/OK or 9
button.
Refer to P.34 regarding each menu item settings.

BACK EXIT

Device Menu

12

Cue/Rev Sound
Beep

Reset Settings
USB Class
Time & Date
Power Save

BACK EXIT

Beep

On
Off

BACK EXIT

Beep

On
Off

On
Set

F1, F3 button
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Cue/Rev Sound (Cue/Rev Sound)

1 Select [Cue/Rev Sound] at the [Device
Menu] screen, then press the PLAY/OK
or 9 button.
Refer to P.34 regarding each menu item settings.

2 Press the + or – button to select [On]
or [Off].
On...The Cue(Cue)/Review(Rev) playback tone is On.
Off...The Cue(Cue)/Review(Rev) playback tone is Off.

3 Press the PLAY/OK button to complete
the setup screen.
[On Set] or [Off Set] will light up on the display, and
it will return to the [Device Menu] screen.

If you press the  0 or F1(BACK) button the setting
will be cancelled and it will return to the [Device Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

4 Press the F3(EXIT) or 0 button to
complete the setting.

PLAY/OK,+, –,
9, 0
button

BACK EXIT

Device Menu

USB Class
Reset Settings

Beep
Cue/Rev Sound
Power Save
Time & Date

BACK EXIT

Cue/Rev Sound

On
Off

BACK EXIT

Cue/Rev Sound

On
Off

On
Set

F1, F3 button

The playback tone of Cue (Cue) operation and
Review (Rev) operation can be set to On or
Off (☞P.28).

PLAY/OK
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1 Select [Device Menu] at the [Format]
screen, then press the PLAY/OK or 9
button.
Refer to P.34 regarding the menu’s various setting
items.

2 Press the + or – button to select  [Start]
option.

3 Press the PLAY/OK button to confirm
[Start] selection.

Format

Data will be 
cleared

F
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BACK EXIT

Device Menu

Cue/Rev Sound

12

Power Save
Time & Date
USB Class
Reset Settings
Format

BACK EXIT

Format
Start
Cancel

PLAY/OK PLAY/OK,
+, –, 9,
button

Cards that have been used in non-Olympus
devices, or cards that are not recognized by
the recorder, must be formatted before they
can be used with the recorder.
To familiarize yourself with the formatting
process, read the steps below.
The recorder ’s menu settings cannot be
initialized. The initialization of menu items
should be set up through DSS Player or the
recorder’s [Reset Settings].

Formatting the Card (Format)
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To return the recorder’s menu settings
to their original status from the time of
purchase (initial settings), perform the
setting from [Reset Settings] in the
[Device Menu], or perform the same
operation by using DSS Player.

Initializing the Recorder’s Menu
Settings (Reset Settings)

4 Press the + or – button again  to select
[Start] option.

5 Press the PLAY/OK button again to
initiate the formatting process.

[Format Done] displays when formatting ends.

BACK EXIT

Format

Are You Sure?
Start
Cancel

Format

Format !

Format

Format Done

BACK EXIT

Device Menu

Cue/Rev Sound
Power Save
Time & Date
USB Class
Reset Settings
Format

Notes
• The time required to format cards differs depending on

the capacity of cards. Do not interrupt the formatting
process by the following operations. Doing so will
damage the data or card.
- Remove the card.
- Remove the batteries.

• When the card is formatted, all the stored data, including
locked files, are erased.

• If an unformatted card is inserted, the recorder
automatically displays the format option in the menu.

• SD cards for which the SD card lock is enabled cannot
be initialized.

• Formatting on the recorder will be Quick Format. If you
format the card, information of file management is
refreshed and the data inside the card is not deleted
completely. When handing over and disposing the card,
be careful about the data leakage from the card. We
recommend the card to be destroyed when you dispose
the card.

Formatting the Card (Format)
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Check System Information (System Info.)

System information about the recorder like its
[Model Name], [Version] and [Serial] can be
displayed.
In this recorder, you can check the Card Information
(☞ P.9) and File Information (☞ P.37).

PLAY/OK PLAY/OK,
9, 0
button

1 Select [System Info.] at the [Device Menu]
screen, then press the PLAY/OK or 9
button.
[Model Name] [Version] [Serial] will appear.
Refer to P.34 regarding each menu item settings.

2 Press the PLAY/OK, 0 or F1 (BACK)
button.

3 Press the F3(EXIT) or 0 button to
complete the setting.

BACK EXIT

Device Menu
Time & Date

12

USB Class
Reset Settings
Format
Card info.
System Info.

BACK EXIT

System Info.

Model Name
DS-3400
Version
1.00
Serial
123456789

F1, F3 button
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Changing the USB Class (USB Class)

PLAY/OK PLAY/OK,+, –,
9, 0
button

1 Select [USB Class] at the [Device Menu]
screen, then press the PLAY/OK or 9
button.
Refer to P.34 regarding each menu item settings.

2 Press the + or – button to select
[Composite] or [Storage].
Composite...In the 3 classes of Storage, USB audio
and human interface, USB connection is possible.
While USB connection in [composite], the recorder can
be used as the USB speaker and the USB microphone.
Storage...USB connection is possible in only
Storage class.

3 Press the PLAY/OK button to complete the
setup screen.
[Composite Set] or [Storage Set] will light up on
the display, and it will return to the [Device Menu]
screen.

If you press the  0 or F1(BACK) button the setting
will be cancelled and it will return to the [Device Menu].
Pressing the F3(EXIT) button will cancel the
contents being set and take you out of the MENU.

4 Press the F3(EXIT) or 0 button to
complete the setting.
When this recorder is connected to the computer
for the first time after being changed to
“Remote(Composite)”, the driver will be installed
automatically to the computer.

BACK EXIT

Device Menu
Beep

Power Save
Time & Date
USB Class
Reset Settings

Cue/Rev Sound

BACK EXIT

USB Class

Composite
Storage

BACK EXIT

USB Class

Composite
Storage

Composite
Set

You can set the USB class of this recorder with
a USB connection to [Composite] or [Storage].
Set to [Composite] when using this recorder
as a USB speaker or a USB microphone.

F1, F3 button
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Customizing the Recorder

You can customize various specifications of the
recorder when using DSS Player (☞ P.59).
For more details, refer to the Online help for
DSS Player (☞ P.63).

The Recorder’s Customized Settings

Common Settings

You can set the default values for each of the
recorder ’s Menu items.

Administrative Settings

❏  General
Accessibility
You can perform various settings related to user
authorization, such as prohibiting both file erasure
and MENU settings.

Splash Message
You can set the contents that appear in the
message which is displayed during startup.

Main Button Guide
You can set the Main Button Guide. Main Button
Guide shows the Main Button status on the LCD
of the recorder.
Alarm
You can set occasions for the recorder’s alarm or
beep noise to sound.

❏  Display
• You can select a default pattern for display

during recording from 5 patterns.
• On the 2nd line of the LCD, you can display

File Name or Work Type instead of Author ID
which is currently displayed in the NEW, STOP,
REC, PLAY, CUE/REV, FF/REW or ERASE
mode.

❏  Device Security
You can perform various settings related to the
recorder’s device lock.
• Device lock function ON/OFF.
• Settings related to the timing for setting the

device lock.
• Password settings.
• Changing the number of allowable input errors

(mismatches) for the password.

❏  Author List
You can perform settings related to the Author,
such as Author registration.

❏  Work Type List
You can perform settings related to the Work Type,
such as Work Type registration.

❏  Device Folders
You can perform various settings related to the
recorder’s folders.
• Changing the number of folders and folder

name.
• Auto Lock setting which locks files recorded in

designated folders.
• Encryption Password setting which encrypts

files recorded in designated folders.
• Work Type settings for each folder.

❏  Recording
You can perform various settings related to the
recorder’s Dictation.
• Recording format (DSS Pro/DSS Classic)

selection.
• Recording mode (Overwrite/Append/Insert)

setting.
• Settings related to eligible f i les when

downloading to a PC (All files/Finished files).

❏  Programmable Buttons
You can change the allocated functions for the
Programmable Smart Buttons (F1, F2, F3
buttons).
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DSS Player Software

The DSS Player is a fully featured software tool that provides a simple to use but sophisticated
method of managing your recordings. Some of the features of the DSS Player are:
• Automatic startup of the application by connecting the device.
• Automatic download of Dictation by connecting the device.
• Backs up downloaded Dictation (Windows only).
• Automatic transmission of downloaded Dictation to addresses specified through e-mail and
  FTP (Windows only).
• Automatic transmission of transcribed documents through e-mail and FTP, as well as Dictation
  and link management (Windows only).
• Voice recorder’s menu setting.
• Customize functions on the recorder (Windows only).
• Direct recording and editing of existing Dictation through Voice recorder’s button.
• Recording Instruction Comments and Verbal comments (Windows only).
• Encrypt the Dictation within the folder by encrypting the folder itself (Windows only).

Make sure that your computer meets the minimum requirements listed below. Please check
with your system administrator or your Olympus Professional Dealer.
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Macintosh

Minimum Requirement

DSS Player Software

Windows

Operating System:

CPU:

RAM:

Hard drive space:

Display:

USB port:

Operating System:

CPU:

RAM:

Hard drive space:

Drive:

Display:

USB port:

Audio I/O terminals:

Notes
• Macintosh version does not support voice recognition software.
• Currently supported OS are listed on our Web page. For the latest information, please visit the Olympus Web site at

http://www.olympus-global.com/en/global/.

Windows 2000 Professional Service Pack 4
Windows XP Home edition Service Pack 2,3
Windows XP Professional Service Pack 2,3 (32bit/64bit)
Windows Vista Home Basic, Service Pack 1 (32bit/64bit)
Windows Vista Home Premium, Service Pack 1 (32bit/64bit)
Windows Vista Business, Service Pack 1 (32bit/64bit)
Windows Vista Enterprise, Service Pack 1 (32bit/64bit)
Windows Vista Ultimate, Service Pack 1 (32bit/64bit)
Windows Server 2003 (32bit/64bit)

Windows 2000/XP: Intel Pentium III 500MHz processor or more
Windows Vista: Intel Pentium III 800MHz processor or more
Windows Server 2003: Intel Pentium III 550MHz processor or more

Windows 2000/XP: 128MB or more (256MB or more recommended)
Windows Vista: 512MB or more (1GB or more recommended)
Windows Server 2003: 256MB or more

Dictation Module: 70MB or more;
(700MB or more with Microsoft .NET Framework Version 2.0 not installed)

CD or DVD drive

800 x 600 pixels or more, 65536 colors more (16.77 million colors or more
recommended)

With the Dictation Module: One or more free ports available

With the Dictation Module: A Microsoft WDM- or MME-compliant and
Windows-compatible sound device

Mac OS X 10.3.9 - 10.5

Power PC G3 500MHz or more/Intel Core Sole/Duo 1.5GHz or more

256MB or more (512MB or more is recommended)

200MB or more

1024 x 768 pixels or more, 32000 colors more

One or more free ports
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Installing DSS Player Software

Be sure to confirm the following before installation:
• Exit all running applications.
• Eject the floppy disk/CD/DVD if you are using one.
• If you are running Windows 2000/XP/Vista or Mac OS X on the network, you need to log on
  as an Administrator.

Windows

For the Windows version, there is an
installation method for individuals and one for
administrators to install on multiple client PCs.
An explanation of the installation method for
individuals installing the software on a single
PC will be provided here.

1 Insert Olympus DSS Player CD into the
CD-ROM drive.
The installation program will start automatically.
If the installation program does not start
automatically, browse your CD-ROM drive and
execute “launcher.exe”.

2 The launcher will startup.
Select the language you would like to install from
the upper-left pull-down menu and click [DSS
Player Pro Installation].

3 The Install Wizard will begin.
Once you have consented to the licensing
agreement, enter your name, company name, and
license ID number (serial number).
The license ID number is printed on the license
ID card included inside the recorder package.

4 Proceed with the installation according
to the instructions on the screen.
Select [Select basic settings for DSS Player
Wizard] by using [Individual User Settings].

Macintosh

1 Insert Olympus DSS Player CD into the
CD-ROM drive.

2 Double-click the CD icon.

3 Double-click the setup icon.
The Install Wizard will begin.
Once you have consented to the licensing
agreement, follow the instructions on the screen
to complete the installation.

4 Proceed with the installation according
to the instructions on the screen.

5 You will be requested to restart, so
conduct a restart by following the
instructions.
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Windows

1 Exit DSS Player program.

2 Click the [start] button on the taskbar.

3 Select [Add/Remove programs] from the
[Control Panel].
A list of installed applications is displayed.

4 Select [Olympus DSS Player Pro], then
click the [Change/Remove] button.

5 Proceed with the uninstallation
according to the instructions on the
screen.

Macintosh

1 Exit DSS Player program.

2 Double-click “DSS Uninstaller” in
[Application] = [DSS Player] folder.
An uninstaller is displayed.

3 Proceed with the uninstallation
according to the instructions on the
screen.

Note
• The dictation fi les you made are stored in the

[MESSAGE] folder. If you don’t need them, delete them.
You can confirm the location of the [MESSAGE] folder
by clicking on [Options] in the [Tools] menu before
uninstalling.

Uninstalling DSS Player Software
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Using Online Help

For information on the DSS Player usage and features, refer to the Online help.
To start Online help:

Windows

1 Click the [start] button, then select [All
Programs], [Olympus DSS Player Pro],
[Dictation Module Help].

2 While DSS Player is running, select the
[Help] menu, [Contents].

3 While DSS Player is running, press F1
on the keyboard.

Macintosh

While DSS Player is running, select [DSS
Player Help] from the [Help] menu.

Note
• Online help is available after the DSS Player is installed

(☞ P.61).
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Connecting to Your PC Using the USB Cable

1 Connect the USB cable to the USB port of the PC.

2 Confirm that the recorder has stopped and connect a USB
cable to the connection port on the recorder.
If [Remote] is displayed on the recorder, it indicates proper connections.

Once you connect the recorder to your PC, the recorder will be powered
through the USB cable.
While PC connection, the SD card is recognized as the respective
removable disk drive.

Disconnecting from Your PC

1 Click the   on the task bar located at the lower-right corner
of the screen. Click [Safely Remove Hardware].
The drive letter will differ depending on the PC being used.

2 Disconnect the USB cable.

Macintosh

Windows

1 Move the icon of the recorder's drive displayed on desktop to trash
box by drag and drop.

2 Disconnect the USB cable.

1
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Connecting Recorder to PC

Notes
• NEVER remove the card or disconnect the USB cable while the record indicator light is flashing. If you do, the data on

the card will get destroyed.
• Some PC’s may not supply sufficient power and the recorder fails to connect. Refer to your PC User’s Manual regarding

the USB port on your PC.
• Do not connect the recorder to a PC by using a USB hub. Make sure to connect to a USB port on your PC.
• Make sure to push the cable connector all the way in. Otherwise, the recorder may not operate properly.
• This is an operational environment for saving the files recorded by this recorder to your PC with USB connection.
• Even if operational environment is satisfied, we do not support upgraded OS, the multi-boot environment or self-modified

computers.
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Running DSS Player Software

Macintosh

Disabling Automatic Start

1 Click the Dock’s System Preferences.

2 Click Device Detector.

3 Turn the automatic startup setting Off.

Windows

Manual Start

1 Double click the DSS Player icon for the
folder in [Application] = [DSS Player].
All program menu will be displayed.

2 Register user information.
The user’s registration screen will be displayed
at the time of initial startup. Please input the serial
number. Please see the seal attached to the CD-
ROM package included with the DSS Player, for
the serial number. After the input has ended, click
[OK] to complete the registration.

Disabling Automatic Start

1 Right-click the Device Detector in the
System Tray in the lower right-hand
corner of the screen, then select
[Settings...].

2 Click [DSS Player Pro Dictation Module].
The check mark on [DSS Player Pro Dictation
Module] disappears.

Manual Start

1 Click the [start] button, then select [All
Programs].
All program menu will be displayed.

2 Select [Olympus DSS Player Pro],
then click [Dictation Module].

By default, connecting the recorder to your PC, will start the application automatically. Connect to
your PC Using the Cradle.
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Using as External Memory of the Computer

When the recorder is connected to your PC, it will be recognized on your PC as a removable drive.
You can view and access the recorder card from My Computer and download data from the card to
your PC using standard windows copy/move and delete commands. You can also upload data from
the PC to the card in the recorder in the same way.

Example: Copying Data from PC to Card Using Explorer or Finder

1 Connecting the recorder to your PC.
For connection procedure, refer to “Connecting to Your PC Using the USB Cable” (☞ P.64).

2 Open Windows Explorer or Finder window.
[Removable disk] is displayed.

3 Copy the data.
While the data are being written or copied, the record/play indicator light on the recorder will flash.

4 Unplug the recorder from a computer.

Note
• NEVER remove the card or disconnect the USB cable while the record indicator lamp is flashing. If you do, the data on

the card will get destroyed.
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Alarm Message List

Message
Battery Low

File Protected

Index Full

Folder Full

Erase Error

Card Error

Unsupported
Card

Memory Full

Format Error

System Error

Insert Card

Action
Replace with new batteries (☞ P.12).

Unlock the file (☞ P.40).

Erase index marks that are no longer
required (☞ P.47).

Erase unnecessary files (☞ P.29).

Erase unnecessary files (☞ P.29).

Erase once again.
When an Erase Error occurs format
the card

Insert a compatible card (☞ P.16).

Please remove the card.

Erase files that are no longer required
or insert another card.

Reformat the card (☞ P.54).

This is a malfunction. Contact the
place of purchase or Olympus
Service Center for repair.

Insert a card (☞ P.16).

Explanation
Battery power is getting low.

Attempt to delete a locked file.

The file is full of index marks (maximum
of 32 marks).

The folder is full of files (maximum of 200
files).

The destination folder already has the
maximum number of files (200).

An error occurred while erasing.

An incompatible card was inserted.

The card cannot be used with this
recorder.

The card has no remaining memory.

There was an error while formatting the
card.

System error detected in the recorder.

There is no card inserted.
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Troubleshooting

Probable cause
The batteries are not loaded properly.

The batteries are dead.

The recorder is in power off mode.

The recorder is in power off mode.

The batteries are dead.

The card does not have enough memory.

The card is unformatted.

The maximum number of files has been
reached.

The SD card is locked.

The earphone is connected.

The volume level is set to 0.

The file is locked.

The SD card is locked.

The recorder was shaken during
recording.

The recorder was placed near a cell
phone or fluorescent lamp while
recording or during playback.

The microphone sensitivity is too low.

The maximum number of index marks
(32) has been reached.

The file is locked.

The SD card is locked.

Wrong folder.

Sometimes a connection cannot be made
with some PCs running Windows XP or
Vista.

Symptom
Nothing appears
on the display

Won’t start

Unable to record

No playback tone
heard

Unable to erase

Noise heard
during playback

Recording level
too low

Unable to set
index marks

Cannot find the
recorded file

Cannot connect
to a PC

Action
Verify polarity is correct (☞ P.12).

Replace with new batteries (☞ P.12).

Turn the recorder ON (☞ P.14).

Turn the recorder ON (☞ P.14).

Replace with new batteries (☞ P.12).

Erase unnecessary files or insert
another card (☞ P.16, 29).

Format the card (☞ P.54).

Check another folder.

Unlock the SD card lock (☞ P.8).

Unplug the earphones to use the
internal speaker.

Adjust the + (Volume) button.

Unlock the file (☞ P.40).

Unlock the SD card lock (☞ P.8).

Move the recorder.

Set the microphone sensitivity to
Conference mode and try again (☞
P.23).

Erase unnecessary index marks
(☞ P.47).

Unlock the file (☞ P.40).

Unlock the SD card lock (☞ P.8).

Switch to the right folder.

You need to change the PC’s USB
settings. See DSS Player Online help
for details (☞ P.63).
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Headset: E62, E102
Stereo headset for your PC. A helpful tool for PC based transcription.

Monaural binaural earphone: E20
Noise-cancellation microphone: ME12 (Dictation microphone)
Used to get crisp recordings of your own voice by reducing the effects of ambient noise.
Recommended to improve the accuracy when using voice-recognition software.

External microphone: ME15
A lavalier omnidirectional microphone that clips to clothing. Used to record your own voice or
people near you.

Highly sensitive noise-cancellation monaural microphone:  ME52W
This microphone is used to record sound at a distance while minimizing surrounding noise.

PC transcription kit: AS-5000
The AS-5000 transcription kit provides you with a PC-footswitch, a headset and DSS Player
Pro Transcription Module for easy transcription of DSS recordings.

Connecting cord: KA333
Use to connect the microphone jack of this unit to a radio or other sound source.

Telephone pickup: TP7
Earphone type microphone can be plugged into your ear while phoning. The voice or
conversation over the phone can be clearly recorded.

Ni-MH rechargeable battery and charger set: BC400 (Europe only)
BC400 comes with an Ni-MH rechargeable battery charger (BU-400) and 4 Ni-MH rechargeable
batteries (BR401) as a pack. This charger can quick charge Olympus AA or AAA Ni-MH
rechargeable batteries.

Ni-MH rechargeable battery: BR401
High-efficiency rechargeable long life batteries.
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Speaker
Built-in ø23mm round dynamic speaker

MIC/EAR jack
ø3.5 mm mini-jack, impedance
MIC 2 kΩ, EAR 8 Ω or more

Maximum working output (3 V DC)
250 mW or more (8 Ω speaker)

Input power requirement
Rated voltage: 5 V
Batteries: Two AAA  batteries (LR03) or

Two OLYMPUS Ni-MH
rechargeable batteries

External dimensions
113.5 x 50.0 x 17 mm
(without protrusions)

Weight
105 g (Including alkaline batteries)

* Specifications and design are subject to
change without notice.

* Battery life is measured by Olympus. It
varies greatly according to the type of
batteries used and the conditions of use.

Recording format
DS2 (Digital Speech Standard Pro)

Recording media
SD-card: 512 MB to 16 GB

Input level -70 dBv
Sampling frequency

QP mode: 16 kHz
SP mode: 12 kHz

Overall frequency response
QP mode: 200 to 7,000 Hz
SP mode: 200 to 5,000 Hz

Recording time (1 GB Card)
QP mode: 77 hours 00 minutes
SP mode: 157 hours 50 minutes

Alkaline battery life
Recording:
QP mode: Approx. 24 hours
SP mode: Approx. 30 hours

Playback:
All mode: Approx. 13 hours
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Technical Assistance and Support
DS-3400 is part of the Olympus Professional Dictation System. Your dealer is trained to
troubleshoot and fix many common problems that you may be having with this system. If you
encounter problems using your DS-3400, we recommend that you contact your Olympus
Professional Dealer that sold you the system. If your dealer cannot fix your problem, please call
our technical hotline number or send an E-mail.

◆ For customers in the U.S. and Canada
Phone: 1-888-553-4448
E-mail: distec@olympus.com

◆ For customers in Europe
E-mail : dss.support@olympus-europa.com



For customers in Europe

“CE” mark indicates that this product complies with the European requirements for safety,
health, environment and customer protection.

This symbol [crossed-out wheeled bin Directive 2006/66/EC Annex II] indicates separate
collection of waste batteries in the EU countries.
Please do not throw the batteries into the domestic refuse. Please use the return and collection
systems available in your country for the disposal of the waste batteries.

This symbol [crossed-out wheeled bin WEEE Annex IV] indicates separate collection of waste
electrical and electronic equipment in the EU countries. Please do not throw the equipment
into the domestic refuse. Please use the return and collection systems available in your country
for the disposal of this product.

Applicable Product: DS-3400

L’indication “CE” signifie que ce produit est conforme aux exigences concernant la sécurité,
la santé, l’environnement et la protection du consommateur.

Ce symbole [Poubelle rayée conformément à la directive annexe 2006/66/EC annexe II]  indique
que la collecte des batteries usagées se fait séparement dans les pays EU.
Veuillez ne pas jeter les batteries dans les ordures ménagères. Veuillez utiliser les systèmes
de collection disponibles dans votre pays pour l’enlèvement des batteries usagées.

Le symbole [poubelle sur roue barrée d’une croix WEEE annexe IV] indique une collecte séparée
des déchets d’équipements électriques et électroniques dans les pays de L’UE. Veuillez ne
pas jeter l’équipement dans les ordures domestiques. A utiliser pour la mise en rebut de ces
types d’équipements conformément aux systèmes de traitement et de collecte disponibles
dans votre pays.

Produit applicable: DS-3400

La marca “CE” indica que este producto cumple con los requisitos europeos en materia de
seguridad, salud, medio ambiente y protección al consumidor.

Este símbolo [Directiva 2006/66/EC Anexo II sobre contenedores] indica que se deben separar
las pilas usadas en los países de la UE.
Por favor no tire las pilas en la basura normal. Por favor utilice los sistemas de reciclaje que
existan en su país para tirar las pilas.

Este símbolo [un contenedor de basura tachado con una X en el Anexo IV de WEEE]  indica
que la recogida de basura de equipos eléctricos y electrónicos deberá tratarse por separado
en los países de la Unión Europea. No tire este equipo a la basura doméstica. Para el desecho
de este tipo de equipos utilice los sistemas de devolución al vendedor y de recogida que se
encuentren disponibles.

Producto aplicable: DS-3400
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Declaration of Conformity
Model Number: DS-3400
Trade Name: DIGITAL VOICE RECORDER
Responsible Party: OLYMPUS IMAGING AMERICA INC.
Address: 3500 Corporate Parkway, P.O. Box 610, Center Valley, PA 18034-0610,

U.S.A.
Telephone Number: 1-888-553-4448

This device Complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

Tested To Comply
With FCC Standards

FOR HOME OR OFFICE USE
Canadian RFI
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus
as set out in the Radio Interference Regulations of the Canadian Department of Communications.

Cet appareil numérique ne dépasse pas les limites de Catégorie B pour les émissions de bruit radio
émanant d’appareils numériques, tel que prévu dans les Règlements sur l’Interférence Radio du
Département Canadien des Communications.

For customers in North and South America


